
U-Boat
See
Sim Games

UCR
See
Undercolor Removal

Ultra Recorder
This utility can record, play, and convert among any of the following audio
formats: AIFF , SoundEdit , .WAV , sound resource files, System 7 sound files,
CD Audio  tracks, MOD files, and audio tracks in QuickTime  movies. Ultra
Recorder also can play a folder of sounds.

Ultra Recorder can record sounds in the following formats: AIFF (directly to
disk if your equipment is fast enough), SoundEdit, and System 7 sound files.

Ultra Recorder also can turn an AIFF file into a self-playing file (essentially,
bundling the program code needed to play the file along with the sound file)
or a startup AIFF sound, which is a sound packaged in an Extension file that
play at startup.
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Available from many online services, the shareware fee is $10.

See Also
AIFF; AudioShop; MOD; Sample Editor; Sound Sculptor; SoundEffects SoundEdit;
SoundStudio Lite

Ultra SCSI
See
Ports, Future Trends

Undefined Offending Command Message
This error message appears where you are having a problem printing a
document. If you're working with large graphics documents, the document
you're trying to print might be too complex for your printer or the amount
of RAM your printer has. It also might be that you're trying to print too
many pages at once. Turning off the printer and "flushing" the printer's
RAM may do the trick or printing the pages of a complex document one-by-
one rather than sending a command to print 10 or 12 pages.

See Also
Printing; RAM
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Undelete
Undelete (also called Trashback) is a data recovery program that helps you
recover files you've deleted from your drive by emptying the Trash .
Although this module is part of the repair/diagnostic and system
enhancement package MacTools Pro from Symantec (10201 Torre Ave,
Cupertino, CA, 95104-2132, Phone (800) 441-7234. Web site at http://
www.symantec.com), they've introduced a new module called TrashBack that
is much more robust. Symantec recommends using Undelete only if you
didn't install their TrashBack module.

See Also
MacTools Pro; Trash

Undercolor Removal
In the process color  printing process, UCR removes cyan , magenta , and
yellow  ink from beneath areas in which solid black is printed. The
technique is used to reduce ink trapping  and the overall amount of ink
needed for the printing run.

See Also
Color Printing; Gray Component Replacement; Process Color; Spot Color;
Trapping
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Undersea Adventure
Featuring some of the most spectacular movies and special effects seen on
any CD-ROM, this is a terrific program for young scientists. The program
opens with a vivid close up of a shark swimming toward you, and then
veering off to attack underwater photographers who, even though they’re
inside a steel cage, are understandably nervous. And it gets even better.
There are movies of fish, coral reefs, and marine mammals that take you
right up close for a really good look.

Narrations provide interesting facts, and the music track adds to the
experience. In the Seacology Lab, young marine biologists can watch
simulated dissections of 12 different marine animals, learning about them
literally from the inside out. The Undersea Encyclopedia, shown in the
figure, contains over 200 photos, movies, animations, and articles.

There’s a printing function to enable kids to use the information as research
material for school reports. This program is rated for ages 5 to 10, but much
of the content will interest older kids as well. The youngest users can follow
along with the simple text in the Ocean Tour, while older students will get
more out of the encyclopedia and movie sections. Everyone who sees this
program is fascinated by the “virtual reality” 3-D underwater museum.
Travel around in it with the mouse or arrow keys and learn about the exotic
creatures on display.

Finally, play the games included. The best of these is the treasure hunt,
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which has you again swimming through the virtual museum, avoiding the
predators as you head for the room with the treasure. You only have 60
seconds worth of air, so try to avoid bumping into the walls. It can be done,
but younger children may find it frustrating. Still, this is a program they’ll
come back to again and again.

See Also
ADAM; Bumptz Science Carnival; MacFrog; What’s the Secret; Widget
Workshop

Undo/Redo Command
At the desktop , Undo enables you to undo changes in the name of a
document while you're making the change. Within an application, Undo, if
available, enables you to undo your last action.

At the desktop, you might use Undo if you were typing a new name for a
document, and you suddenly realized you had a typo. You could select Undo
( -Z) from the Edit menu  to undo your name change.

The Undo Command is also called the Redo Command because if you select
Undo to undo your last action, you can also select Undo to redo your change.
An example would be: You have a folder named Applications. You decide to
change the name of that folder to Apps, and while you're typing in the new
name you decide it may have been better left named as Applications. You can
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select Undo and it undoes your name change. But if you then decided "Aw,
apps is really an OK name after all." Rather than retyping it, you can select
Undo again (which does a redo at this point) and puts Apps back in as the
name of your folder. You can continue this Undo and Redo scenario as many
times as you like, as long as you don't make any other action. It toggles
between your two choices until you take a different action. Undo is also
available in most Macintosh programs to undo your last action.

There are a number of actions that Undo cannot undo. Undo does not
physically move items at the desktop Level. If, for example, you move an item
into the Trash and decide you want it out of the Trash,  Undo does not move it
back to your hard drive. You have to retrieve it yourself.

Many programs now are taking advantage of the capability to have multiple
undos, and a number have as many as 99 undos. This gives you the
opportunity to make changes as you like without the fear of them being
permanent because you can always go back a few steps, while that document
is open, an undo any changes you didn't like. However, these programs only
remember these undo steps during the session that you're working on. If you
close a document, the undos it was keeping in memory are deleted, so you
cannot close a document, then later reopen it and use the undo feature to take
you back to changes you made before you closed the document.

If an action cannot be undone (and many cannot) the Undo Command
appears grayed out under the Edit menu. In some programs, if an action
cannot be undone, it may read Can't Undo under the program's Edit menu in
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Unicode
Unicode is a method of encoding characters that encompasses all of the
characters in all of the world’s alphabets.

For many years, the ASCII  standard has been used to encode text for use with
computers. Because of its widespread acceptance, ASCII has become the
common language of computer communication. Unfortunately, ASCII limits
communication to the letters, numbers, and punctuation of the Roman
alphabet. Very few languages can be written in their full richness using just
the Roman alphabet. Even extended-ASCII, which includes many accented
characters used in German, French, and Spanish, leaves out much of the
world’s languages.

A big part of the problem is that even extended-ASCII permits only one byte
(or 8-bits) per character. That limits the total number of possible characters

to 28 or 256. This is barely enough to contain the characters used in European
languages, let alone the thousands of other characters used in languages
such as Japanese and Arabic. Other encodings exist for these character sets,
but they are not interchangeable, and using more than one at the same time
(in a document written in Korean and Hebrew, for example) can be a real
headache.

Unicode avoids the problem by using two bytes (16 bits) for each character,

giving enough room in a singe encoding system to include 216 or 65536
individual characters, or glyphs.
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The first version of the Unicode standard includes encodings for the
characters used by all of the world’s major languages and many of its minor
ones. Future versions of the standard will include many more languages and
even “dead” or archaic ones.

See Also
ASCII

Universal Proc Pointer
See
Mixed Mode Manager

Unlocking Files and Disks
Files are locked to prevent them from being accidentally deleted . You can
unlock any document that has been locked by selecting the file and choosing
Get Info  ( -I) from the File menu . This opens the file's Get Info window.
Located in the bottom left corner of this window is a check box  marked
Locked . To unlock the disk, click this check box to deselect the Locked
feature. The file is now unlocked and can be deleted.

To unlock a locked file, follow these steps:

1. Click the file you want to unlock.
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2. Choose Get Info ( -I) from the File menu.

3. In the Get Info window, click the Locked check box to deselect the
Locked feature. The file is now unlocked.

TIP You can also delete locked files by holding down Option while
choosing Empty Trash.

See Also
Check Box; Click; Delete; File Menu; Get Info; Locked

Untitled
This is the default  name given to any new document or folder  to let you
know it has not been named. When you create a new folder with -N, for
example, its name is “untitled folder,” and it is highlighted  to let you enter
a new name. If you choose not to name it, it retains the name “untitled
folder.” If you create another new folder, it is titled “untitled folder 2,”
followed by “untitled folder 3,” and so on.

If you launch  an application and create a new document, its default name is
“Untitled1.” If you create subsequent documents, they are titled “Untitled2,”
“Untitled3,” and so on. This is the Macintosh computer's way of letting you
know these documents have not yet been named or saved.

To name an untitled folder, follow these steps:
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1. Click  the name of the folder to highlight it. The arrow pointer
converts to the I-Beam  cursor.

2. Enter the folder’s new name.

3. Click outside the folder to make the change complete.

To name an untitled document, follow these steps:

1. Choose Save or Save As from the application's File menu

2. The standard Save dialog appears. You may enter a name for the file in
this dialog box under, "Save this document as." Click OK to save the
document with its new name.

See Also 
Arrow Pointer; Click; Cursor; Default; Folder; Highlighting; I-Beam; Launch;
Save

Up Arrow Key
The Up Arrow key enables you to select  items above a selected item in a list.
If, for example, you're in a window displayed in a list view , you can click  a
file  and then use the Up Arrow key to move up the list. Each time you press
the Arrow key, the above file is selected (and the below file is deselected)
until you reach the top of the list. The Up Arrow key can also be used in an
application to navigate up through an open document line by line without
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using the mouse.

There are a number of modifier keys you can use with the arrow keys. Here's
a table of the most common keystrokes using the arrow keys.

Arrow Keystrokes

Sequence Result

-Left Arrow Collapses Expanded Folder

-Down Arrow Open Folder/Open Next File

-Right Arrow Expand Folder

-Up Arrow Go to Previous Folder

-Option-Up Arrow Close to Previous Window

-Shift-Up Arrow In Open/Save Dialog it Selects Desktop

-Option-Left Arrow Collapses All Expanded Folders

-Option-Right Arrow Expands All Nested Folders

Shift-Right Arrow Selects Character to the Right of Text Cursor

Shift-Left Arrow Selects Character to the Left of Text Cursor
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Shift- -Right Arrow Selects Word to the Right of Text Cursor

Shift- -Left Arrow Selects Word to the Left of Text Cursor

See Also
Arrow Keys; Click; File; List Views; Select; Window

upFront
An entry-level 3D program originally developed by Alias. When Alias was
purchased by Silicon Graphics, upFront was acquired by SketchTech. This
program, which has an interface similar to Alias's other modeling package,
Sketch! , sports a variety of modeling tools and exports to multiple file
formats, including Electric Image  or Pixar's RenderMan .

The unusual animation interface uses a tool that draws Spider Walls in the
model to indicate camera direction and angle.

Like Sketch!, upFront can import a 2D image as a background and match the
perspective of the model to the image. This enables you, for example, to
match a 3D model of a table with a picture of an empty room.

Sketch! and upFront address slightly different markets: Sketch! lacks the
animation features of upFront, but offers more modeling and texture and
surface controls. The output quality of upFront is lower than Sketch!

The combination of features upFront offers makes it best for architectural
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and other real-world simulation modeling tasks.

SketchTech
Price: $299
Phone: (612) 379-1435
Web: http://www.diskovery.com/Diskovery/
EPG/Indices/Software/ByPublisher
/Sketchtech.html

See Also
Modeling; Sketch!

Upgrade
You have performed an upgrade when you add or change something in your
hardware or software setup so that you can achieve greater functionality,
capacity, or speed. This function could be as complete as replacing your
Macintosh SE with a new PowerMac, or as minor as adding a new hard disk to
your SCSI chain on the hardware side. The most common forms of hardware
upgrade are CPU Upgrade , memory upgrade , logic board upgrade,
hard disk upgrade, VRAM expansion, and the addition of a cache .

A software upgrade means that you have purchased or received a new
version of a program you already had or a new version of your operating
system. When you replace a software program with one of its competitors, it
is usually called a sidegrade . There is also a special term for certain
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software upgrades, a software update .

See Also
Cache; CPU Upgrade; Hard Disk Upgrade; Logic Board Upgrade; Memory
Upgrade; Sidegrade; System Upgrade; VRAM Expansion

Upgrade Paths, PowerPC Options

PowerPC  upgrades use two different designs: a full logic board upgrade that
completely transforms the older Mac into a new PowerPC model, or a user-
installed PPC upgrade card that plugs into the Mac’s logic board and offers
accelerated performance at a fraction of the price of a full upgrade or new
Mac.

At the top of the heap are the full logic board upgrades for owners of the Mac
IIvx, IIvi, Performa 600, Quadra/Centris 610 and 650, 660AV, 800, and 840AV.

Logic Board Upgrades  Any Mac upgraded with a logic board is identical to
its corresponding Power Mac . Keep in mind that RAM  purchases are
necessary for some owners of converted (upgraded) Mac systems. Apple
continues to offer logic board upgrades to 6100, 7100, and 8100 models.
Upgrades for the AV versions cost an additional $100-$400, depending on the
model. PowerPC upgrade boards are still available from Apple for the
Quadra/LC 605, 475, 575, 580, and 630 Mac and Performa models.

Upgrade Cards  A PowerPC upgrade card is available for every 68040 Mac
made. The PPC upgrade card is a PDS-based plug-in and works in every
Quadra and Centris computer with a standard PDS slot . The PPC upgrade card
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has no SIMM  socket for its own RAM. The Power Macintosh upgrade card
(displayed in the following photograph) adds a PowerPC 601 processor that
runs at twice the clock speed of the host system. Performance gained from
the upgrade depends on the software and tasks run on the system, but
estimates are in the 200-300 percent range for actual systems.

Two upgrade cards are available from DayStar Digital using Apple-licensed
technology. The DayStar PowerPro 601 PowerPC upgrade card provides
upgrades to 7100 and 8100 Power Mac levels at 100MHz and at 66MHz for
Quadra or Centris Macs (see the following figure). The PowerPro can also be
added as a coprocessor to the existing 68040 processor because it is inserted
into the PDS slot  and the 68040 code runs without a performance
degradation typical of emulated systems.

The following table provides an overview of upgrade options.

Upgrade Paths for Macs*

Any compact Mac, Mac II, Iix, Iifx, MacTV, Performa 275,
Performa 6100 series, Power Mac 6100

For extra speed on 68040 Macs, try Connectix Speed Doubler, add more
RAM. For Power Macs: add L-2 cache using a clock accelerator from
Newer or Alacrity or a PowerPC 604-based Total Power application-
accelerator card from Total Impact.

Speed Doubler $55; L-2 cache $125 – 260; Newer or Alacrity clock-
chipper $100 – 300; Total Impact PPC total Power accelerator $1,500
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Mac IIcx, IIci, IIsi, IIvx, IIvi, Performa 600

DayStar 100MHz Turbo 601 PDS card or 66MHz Turbo 601 PDS card. 100-
or 66MHz PPC 601 processor. Requires System 7.5 (not included with
card). Includes 256K cache. 100MHz Turbo: $1,299, 66MHz Turbo: $899.

Mac IIvx, IIvi

Apple Power Mac 7100 motherboard Requires an upgrade to a Mac
IIci before upgrading further. Motherboard  replacement. 80MHz
PPC 601 processor. Requires dealer installation. $1,599 plus $50 for
dealer installation and L-2 cache at $125 to $260.

LC, LC II, LC III, LC 475, Performa 470 series, Quadra 605

Apple 50MHz Processor Upgrade; DayStar 100MHz PowerCard or 50MHz
PowerCard 601 Requires upgrade to Performa or LC 475 before
further upgrade. Processor replacement to 100 or 50MHz PPC 601
processor. Requires dealer installation for Apple processor, DayStar is
do-it-yourself. Both include System 7.5 and ClarisWorks 3.0. A p p l e
Processor: $659 plus $50 dealer installation; DayStar 100 MHz
PowerCard: $999, 50-MHz PowerCard $649

LC 520, 550, 575, 580, 630, Performa 550, 560, 570 series, 630 series,
Quadra 630

Apple 66MHz Processor Upgrade or DayStar 100MHz PowerCard 601 or
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66MHz PowerCard 601 Requires upgrade to Performa or LC 575 or
better before further upgrade. Processor replacement to 100 or 66MHz
PPC 601 processor. Requires dealer installation for Apple processor,
DayStar is do-it-yourself. Both include System 7.5 and ClarisWorks 3.0.
Apple Processor: $659 plus $50 dealer installation; DayStar 100 MHz
PowerCard: $999, 66-MHz PowerCard $649

Centris/Quadra 610

DayStar 100MHz PowerPro 601 PDS card or 40/50MHz PowerPro 601 PDS
card; Apple Power Mac 6100 motherboard. DayStar upgrade is PDS card
with 100 or 40/50MHz PPC 601 processor; DayStar 100MHz PDS card
works at 80MHz on Centris. DayStar cards require System 7.5 (not
included) Apple upgrade is a motherboard replacement with a 66-MHz
PPC 601 processor that requires dealer installation. DayStar 100MHz
PowerPro card: $1,299, NuBus card adapter $79; PowerPro 40/50MHz
card: $529, System 7.5: $98. Apple motherboard: $1,049 plus $50 for
dealer installation

Centris/Quadra 650

Apple Power Mac 7100 motherboard or DayStar 100MHz PowerPro 601
PDS card 100- or 80MHz PPC 601 processor. DayStar PDS card is do-
it-yourself. DayStar cards require System 7.5 (not included). The Apple
motherboard must be installed by a dealer. $1,599 plus $50 for dealer
installation and L-2 cache at $125 to $260. DayStar 100 MHz PowerPro
card: $1,299
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Centris/Quadra 660AV

Apple Power Mac 6100 motherboard Apple upgrade is a
motherboard replacement with a 66MHz PPC 601 processor that
requires dealer installation. Apple motherboard: $1,049 plus $50 for
dealer installation

Quadra 700, 900 series

DayStar 100MHz PowerPro 601 PDS card or 50/66MHz PowerPro 601 PDS
card DayStar upgrade is PDS card with 100 or 50/66 MHz PPC 601
processor; DayStar cards require System 7.5 (not included). D a y S t a r
100MHz PowerPro card: $1,299, PowerPro 50/66MHz: $529, System 7.5:
$98.

Quadra 800 series, Power Mac 8100 series

Apple Power Mac 8500 motherboard. 120MHz PPC 604 processor in a
motherboard replacement. Requires dealer installation. Quadra 800-
owners can upgrade to Power Mac 8100 by installing 8100 motherboard
with 100MHz 601 processor. Price for 8500 motherboard not
determined. 8100 motherboard: $1,999.

Quadra 630, Performa 630 series, 5200 series, 6200 series,
PowerMac 5200, 6200

Apple Power Mac 5300/6300 motherboard. 100MHz PPC 603e processor
motherboard replacement. Requires dealer installation. Performa  and
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Quadra 630 owners require more RAM. $699 – 799.

Power Mac 7200

Apple Power Mac 7500 motherboard. 100MHz 601 processor on a
daughterboard, making future upgrades easy. Requires dealer
installation. Price to be determined.

Power Mac 7500, 8500, 9500

Processors located on swappable daughterboards.

*Information taken from “Choosing the Right Mac: The Paths to Upgrades”
by Roman Loyola, MacUser, December 1995.

Upgrade Card Limitations  What advantages does a new Mac or a logic
board upgrade have over the upgrade card? First, remember that Apple’s
upgrade card cannot be installed in every Mac. The logic board
(motherboard) replacement is practically equivalent to a Power Mac; the
only question is whether the internal hard drive, CD-ROM, and other
hardware can handle this performance improvement. If not, consider a new
Mac. A full motherboard upgrade adds extra features other than just
speed—additional bit-depth, resolution support, and 16-bit sound might be
important in your work.

Second, the performance of the upgrade card is limited because it relies on
the old logic board and bus of the host Mac. Apple has tried to minimize this
limitation by including 1MB of secondary RAM cache on the upgrade card.
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Regardless, the design of the logic board on a full-fledged Power Mac is
better optimized for performance and yields better results than an
accelerated Mac with a 601 chip.

See Also
Motherboard; PDS Slot; Power Mac; PowerPC; RAM; SIMMs

Upgrade Paths, Types of
Upgrading your processor is the fastest and easiest way to accelerate your
Mac. Apple’s latest Macintosh computers provide upgrade slots on the
motherboard  that accept special processor daughterboards. Keep in mind
that only some Mac computers can have the processor chip upgraded
(PowerPC as well as 68040 models), and these may be limited to a specific type
of accelerator.

Processor Upgrades to the Main Motherboard  All Mac models prior to
the PCI-based Power Macs (the 7500, 8500, and 9500) had processors soldered
directly to the motherboard, eliminating the possibility of a processor
upgrade. PowerBook processors are soldered onto the motherboard. Many of
the 68040/68LC040-based Mac models have removable processor chips that
support processor upgrades. The most common processor upgrades are the
addition of a floating point unit (FPU) to a 68LC040-based LC Mac or a
Performa model and the replacement of a 68040 chip with a 68LC040
processor (increases processor speed and adds a floating-point unit to the
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motherboard).

One thing you cannot do is add a PowerPC processor to a 68040 processor slot.
The PowerPC chip won’t fit into the 680x0 chip footprint, and the PowerPC
processor was not created to be interchangeable with 680x0 chips. This is due
to speed limitations of other chips on the motherboard and changes to the
ROM, hard drive, and other hardware components.

Installing Accelerators  Most accelerators require software and hardware
components before they can be recognized by system software. Most 68K
accelerators require the addition of dynamic RAM (DRAM) single inline
memory modules (SIMMs)  on the accelerator card before they are attached
to the motherboard. PowerPC accelerators are designed to use the DRAM on
the 68LC040 or 680409 motherboard; accelerator designs vary from vendor to
vendor.

Apple is actively pursuing owners of traditional Mac systems that accept
PowerPC upgrades and encouraging them to make the transition to the new
architecture. A number of upgrade kits and upgrade cards are available that
enable Mac owners to upgrade their systems to PowerPCs. In addition to Apple
upgrades, third-party options are available that can be inexpensive routes to
PowerPC computing.

Understanding Accelerator Cards  PowerPC and 680x0 accelerators are a
popular choice for increasing raw hardware speed on existing Mac models.
Accelerator card  upgrades, available for many years, can increase Mac
performance without the need to buy a new computer.
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Accelerator cards are the best choice for increasing performance if a lot of
money has been invested in an existing Mac or exchanges are not possible.
Users of older Mac models that have considerable money invested in (older)
RAM , hard drives, or software that cannot be used with the PowerPC should
purchase third-party accelerator boards. Fortunately, there is an accelerator
for nearly every Mac and every Mac operation.

Accelerator boards (as opposed to CPU upgrades) only speed up certain
information paths, such as the SCSI bus or QuickDraw graphic routines. Some
cards are application-specific, such as Radius’ PhotoEngine board, which
speeds up Adobe Photoshop.

One argument against accelerators is that speeding up the clock and
processor is only partially effective because the data bus through which data
flows to the processor still runs at its original (slow) speed. This creates a
bottleneck in the system that the processor cannot alleviate. To get around
the data bus bottleneck, designers usually add high-speed static-RAM
(SRAM)  to the accelerator. SRAM acts as a cache between the main memory
and the accelerator. In older compact Macs and some 020-based designs the
main memory was added directly to the accelerator card to bypass the data
bus. Some new PowerPC accelerators use a high-speed cache and RAM
onboard the accelerator to optimize performance.

This configuration, although better from a performance standpoint,
sometimes justifies the purchase of faster RAM memory. The use of slow
SIMMs causes the accelerator to use more wait-states, slowing the system.

U



Furthermore, the addition of SIMM sockets and memory management chips
increases the cost of the board; vendors do not apply this design to low-cost
or a wide range of products given the cost-sensitive nature of the current
market. Macs have never been more inexpensive. Their low cost seriously
affects the accelerator market because the cost of an accelerator card is
closer to the cost of an entire Mac system.

See Also
Accelerator Cards; Motherboard; PDS Slot; Power Macs; RAM; SIMMs

Uploading Files
The opposite of downloading a file from an information service or a
network  such as the Internet . By uploading a file, you transfer data from
your computer to a remote site. The remote site might be a commercial
online service,  a bulletin board service,  an FTP site,  or other site on
the Internet .

See Also
Asynchronous Transmissions; Bulletin Board Service; Commercial Online
Service; FTP; Internet; Network; World Wide Web

UPP
See
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Mixed Mode Manager

Users and Groups
For Macintosh users on a network , this control panel  enables you to allow
access to individual users, or groups of users, that you create. These users, or
groups of users, can access only the files and folders that you specifically
designate they can access in the Sharing Dialog Box.

There are four types of users that can you allow access to your shared disk
from this control panel; a registered user (a named individual network user),
a guest (anyone signing on to the network), a group (a collection of
individuals); and the owner (you.)

When you open the Users and Groups Control Panel for the first time, you'll
only see two icons (they look like cartoon faces): one representing you (the
owner) and one representing a guest.

You create new users by choosing New User from the File menu when the
Users and Groups Control Panel is open.(The Users and Groups Control Panel
looks like a standard Finder window, but it is a control panel.) A new user
icon is created that looks like a cartoon face, and you can name this icon to
help you keep track of the user (generally you would use the person's name
for organizational purposes). Creating individual users is for limiting access
on a person by person or group by group basis. If you're going to enable
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open access to your files by all users, you don't have to create individual
names for each users, just have all users sign on as guest.

Another feature is the ability to create groups. The benefit to using groups is
that you can have separate groups of individuals and assign access privileges
to an entire group at once, rather than assigning access privileges to each
individual user. In a large company, there could be hundreds of users and
assigning individual access privileges could become very time consuming.

You create a New Group by choosing New Group from the File menu while the
Users and Groups Control Panel is open. A cartoon icon with two faces
(indicating it's a group) will appear as "untitled" and you can name the
group (use a descriptive name if possible). You can add individual users to
this group by dragging and dropping their individual user icons onto the
group icon. (This will not delete their icon from the Users and Group Control
Panel main window; it will just add a copy to the group. This enables you to
have one user assigned to many different groups.) To see which users are in
a particular group, double-click the group icon. To remove a user from a
group, simply drag the users icon into the Trash. (Again, this will not delete
their original icon from the Users and Groups Control Panel main window.)

See Also
Control Panel; Groups; Icons; Network

UserTalk
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See
Frontier

Utility
A utility is a program designed to do maintenance, organization, and
housekeeping-type duties on the Macintosh. For example, if you have a file
that is too large to fit on a disk, you might want to use a compression  utility
to compress the file's size down to something more manageable. Or if you're
having intermittent problems with your Mac, you can run a repair utility to
diagnose your System software  and repair any problems it might
encounter. These utilities can come in a variety of sizes and formats and can
be stand-alone applications or they can be in the form of control panels  or
extensions  that are added to the system at startup . Apple has utilities of its
own like Disk Repair , which is for repairing System software problems,
and Apple's HD SC Setup , which is for formatting hard disks. Both of these
are of the stand-alone variety.

The difference between utilities and regular applications is that utilities
generally don't create a document, whereas most applications (besides
games) are usually designed to create some sort of document—a letter,
spreadsheet, graphic, or database.

Utility Developer / Purpose / Benefit
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RAM Doubler Connectix / Makes your Mac think it has more RAM /
Enables you to open more apps

Now Utilities Now Software / Repair, diagnose and enhance your
system / Adds system functionality and can repair
common problems

QuicKeys CE Software / Macro Program / Enables you to
automate repetitive tasks

After Dark Berkeley Systems / Screen Saver / Provides screen
burn-in protection and entertainment

Conflict Catcher Casady and Greene / Controls loading of extension /
Helps you isolate system conflicts

Virex Datawatch / Virus detection / Helps keep your
computer free of Viruses

SAM Symantec / Virus Detection / Helps keep your
computer free of Viruses

Norton Utilities Symantec / Norton Utilities / Symantec

StuffIt Aladdin / File Compression / Reduces size of files for
backup or modem transfers

Disk First Aid Apple / Repair Utility / Fixes some common software
problems
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DiskDoubler Pro Symantec / File Compression / Reduces size of files for
backup or modem transfers

Disk Express II Alsoft / Disk Optimization / Speeds hard disk access by
defragmenting files

See Also
Compression; Control Panels; Disk Express II; Disk First Aid; DiskDoubler Pro;
Extensions; HD SC Setup; Norton Utilities; Now Utilities; RAM Doubler; Startup;
System Software; StuffIt; Virex

uuLite
See
Decoding/Decompressing Files

uuUndo
See
Decoding/Decompressing Files
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